
Active@ Disk Image v.2.0 

Copyright © 1998-2004 Active@ Data Recovery Software 

Lsoft Technologies Inc. 

 

 

USERS MANUAL 
 

PRODUCT OVERVIEW 
 

Active@ Disk Image is a DOS-based solution designed for complete backup and restoration of 

the whole HDD as well as the particular FAT / NTFS partitions and logical drives.  

 

You can create compressed and non-compressed raw images (containing all drive’s data - a 

mirror of drive’s surface stored in one or set of files) as well as compressed data images 

(containing the only used drive’s clusters, this can save you a space and increase speed). 

 

Unique feature of Active@ Disk Image is the ability to open disk images and preview files and 

folders inside before image restoration. You can even copy any specific files or folders from the 

image to another location.  

 

Using Active@ Disk Image you can perform backup of you PC system to another hard drive or 

to the network server storage and restore it from there back in the event of a system crash or 

loss of important information.  In case of dealing with disk containing accidentally deleted files 

you can use Active@ Disk Image to make an image of the disk (snapshot), from which you can 

later try to restore deleted file using data recovery utilities like Active@ UNDELETE or Active@ 

UNERASER without the risk of overwriting important data on original disk. In case when your 

disk has started getting bad clusters (basically falling apart) you can effectively stop this 

process to preserve whatever readable as an image and try to restore data later. 

 

SYSTEM REQUIREMENTS 
 

Active@ Disk Image for DOS requires: 

- AT compatible CPU with 386 or greater processor 

- 16 MB of RAM 

- 1.44 Mb floppy disk drive or CD-ROM drive 

- EGA 640x480 or better screen resolution 

- Bootable Floppy or CD-ROM containing DOS, or startup disk for Windows 95/98 

- Source HDD of type IDE/SATA/SCSI attached 

- Destination FAT/FAT32 volume that may be local or mapped network drive for storing images 



 

DIFFERENCES BETWEEN FREE AND COMMERCIAL VERSIONS 
 

Active@ Disk Image version                                            Free Pro 

   
Can be placed to and run from DOS bootable floppy or CD-ROM Yes Yes 

Displays complete HDD, partition and disk image information Yes Yes 

   

Creates Compressed and Non-Compressed Raw Image for the physical drive (HDD) Yes Yes 

Restores Non-Compressed Raw Image back to the physical drive    Yes Yes 

Restores Compressed Raw Image back to the physical drive    No Yes 

   

Creates Compressed and Non-Compressed Raw Image for the partition (logical drive) Yes Yes 

Restores Non-Compressed Raw Image back to partition or drive Yes Yes 

Restores Compressed Raw Image back to partition or drive No Yes 

   

Creates Compressed Data Image for any partition on HDD Yes Yes 

Restores Compressed Data Image back to partition or drive No Yes 

   

Disk Viewer displays contents of any physical sector on the drive or within Disk Image Yes Yes 

Preview mode allows to view all files and folders inside disk image before restoration Yes Yes 

Allows to copy specific files and folders from the image to another location Yes Yes 

   

Supports IDE / ATA / SCSI / USB  drives Yes Yes 

Supports large (more than 128GB) size Hard Disk Drives and partitions  Yes Yes 

Supports FAT12, FAT16, FAT32, NTFS, NTFS5 file systems Yes Yes 

Supports partitions created in MS-DOS, Windows 95/98/ME/NT/2000/XP/2003 Yes Yes 

   

 

 

 

                

OPERATING PROCEDURES 
 

In order to run Disk Image you must boot in MS-DOS mode. For this you must have a 

bootable floppy disk containing MS-DOS system files. Another option is to create a bootable 

CD (if your system has a CD burner and can boot from CD) 

Bootable floppy disk (startup disk) preparation 

    

If you do not have bootable floppy, you can prepare such disk from MS-DOS, Windows 95/98 

the following ways: 

    

- If you boot in MS-DOS or in Command Prompt mode of Windows 95/98, insert blank floppy 

and type: 

  
 C:\> FORMAT  A:  /S 

 

… and follow the instructions on a screen 

  

 

- If you boot in Windows 95/98/ME, go to the "Control Panel" then "Add/Remove Programs", 

then switch to tab "Startup Disk" and click button "Startup Disk..." and follow the instructions  

  

- If you boot in Windows XP, insert blank floppy, right-click A: drive, choose "Format...", check 

"Create an MS-DOS startup disk" option and click "Start" button 

 



Copy Active@ Disk Image (DISK_IMG.EXE) and DOS-extender (DOS4GW.EXE) to the bootable 

floppy disk. 

 

Program start and information display 

 

- Boot from the floppy or CD-ROM in DOS mode, or Command Prompt mode in Windows 95/98 

 

- Run Active@ Disk Image by typing: 

 
 A:\> DISK_IMG.EXE 

 

- You will see a list of devices and drives on the left side and information panel on the right: 

 

 
 

Use [Up], [Down] arrows to select a drive or disk you want to see information for. 

 

 

Disk Image creation 

 

A "Disk Image" is a copy of the drive saved in file or set of files. Disk Image is used for 

backup/restore purposes as well as for the analysis and recovering of deleted files. Disk Image 

for the whole Hard Disk Drive or for a particular partition (or logical drive) can be created 

using Active@ Disk Image software. 

 

Starting Disk Image creation process 

 

- Start Active@ Disk Image 

 

- Select the device, for example “Hard Disk Drive (80h)”, if you want to create image for the 

whole hard disk (HDD) 

 or 

- Select the logical drive, for example “Local Disk (C:)”, if you want to create image for the 

particular partition (volume) 

 

- Verify source disk parameters (name, serial, file system, size, etc) on the right side. If you 

want, you can press [ENTER] to scan a partition and preview files located there (for logical 

drives only). 

 



- Press [Ctrl]+[I] to create Raw Image. Raw image is an image containing all drive’s data - a 

mirror of drive’s surface stored in one file or set of files. It includes used as well as unused 

clusters and sectors. This means that all existing and even some deleted files will be copied to 

the image. Raw image has usually size larger than Data Image, but gives full picture of data, 

no one bit of data is missed in this case. 

 or 

- Press [Ctrl]+[D] to create Data Image (for logical drives and partitions only). Data Image – 

image containing only used drive’s clusters. When you recover Data Image later on – all 

unused clusters would be just zeroed. This approach however can save you space and increase 

speed of disk image creation. 

 

- Create Image dialog appears: 

 

 
 

- You can see image type: [Raw] and source: [Local Disk (C:)] at the dialog title. 

- You can type your description for an image to be created. In the example above the 

description typed is “My System Disk Image…” 

- You can move between the dialog controls via [TAB] and [SHIFT]+[TAB] keys 

- You can choose a compression type using arrows keys: 

o None – Fast method but takes lots of space – namely size of drive to be 

imaged. However this format is compatible with most of other tools. 

o Minimum – Relatively fast. Speed of image creation takes precedence over 

size of output image 

o Medium – Speed and size of image creation have equal priorities 

o Maximum – Size of resulting image takes precedence over speed of image 

creation 

In the example above Maximum compression method is chosen. 

- You can specify a location of resulting image using [TAB] key to move through the 

Drives: and Folders: controls and arrows to select a particular Drive and Folder. 

Press [ENTER] to enter the folder or subfolder if you want to. You will see all local 

and attached network drives as a destination for the image. In the example above 

location “H:\My Documents” is chosen. 

- Type resulting file name into Image File: box. In the example above  

“C-image.dim” is chosen.  

- Move cursor to [  OK  ] button and press [ENTER] or [Space] to start disk image 

creation process. 

 



- You can see a progress of image creation and stop the process anytime by pressing [ESC]: 

 

 
 

 

Created C-image.DIM file is a text file containing image parameters. Since files on FAT 

volumes are limited to 2GB, image file will be automatically splitted into 2GB data chunks. 

Image Data chunks would be: C-image.000, C-image.001, C-image.002, etc…  

 

If there is not enough space exists on a target drive, you will be prompted for another location 

where you want to store remaining chunks.  

 

Disk Image restoration 

 

- Start Active@ Disk Image 

- Press [Ctrl]+[R] to launch Disk Image Restoration dialog: 

 

 
 

- If you have created an image using Active@ Disk Image earlier (there is a valid configuration 

(*.DIM) file), press [ENTER] or [Space] to load image info from the image configuration file: 

 



 
 

- Use arrows and [TAB] key to move between drives and folders tree. When you found and 

selected valid *.DIM file in Files: box, press [ENTER]. In the example above “backup.dim” file 

located on “G:\” is chosen. 

 

- Information from image configuration file will be loaded into the memory and you will see 

image parameters in dialog: 

 

 
 

 Verify image parameters: Description, type, chunks, geometry and press [NEXT>] 

 

- If you have created an image using previous v. 1.0 of Active@ Disk Image or other tools (i.e. 

you don’t have a configuration *.DIM file), you are to compose an image from chunks and set 

up image parameters properly before you can start image restoration: 

Use [TAB] and arrows to move through dialog controls and specify the following parameters: 

- Image Type: Physical Device (for HDD) or Logical Drive (for a partition) 

- Chunks: press [Add] button to locate and add all drive image’s chunks to the list 

- Chunks may be located on one drive or on different locations 

- Drive Geometry (for HDD images only) 

Despite you can manually specify list of data chunks and set image parameters, we urge you 

always to use .DIM files 

- Destination Drive dialog will appear: 

 



 
 

  Using arrows, select Hard Disk where you want to restore image to and press [NEXT>]. 

 

- If you are restoring a disk image of a partition (logical drive), Destination Partition dialog will 

appear: 

 

 
 

 You can:  

- select an existing partition (having size equal or large) to restore disk image to 

- restore it to Unallocated space 

- delete existing partition and restore to Unallocated space that would appear 

- set Active flag to assign boot priority to partition being restored 

 



- After pressing [NEXT>] you will see a final confirmation dialog: 

 

 
 

- Type: RESTORE (case-sensitive, in uppercase) and press [ENTER] to proceed with disk 

image restoration. Be careful, data located on the drive where you want to restore image to 

will be completely overwritten by image data, and no recovery would be possible thereafter. 

 

- You will see a progress of image restoration. To stop the process anytime - press [ESC]. 

 

- After restoration is complete you will be prompted to reboot the machine. 

 

Working with Disk Images 

 

Checking Disk Image for consistency 

Checking of disk image consistency is needed when you are not sure whether disk image is 

safe or not to be recovered. For example some chunks are missing in configuration file, or bad 

clusters were recently detected on the drive where disk image is located. This could affect 

future recoverability of disk image, so it is recommended to perform this procedure when you 

are not sure of image condition. 

 

To check disk image for consistency: 

- Start Active@ Disk Image 

- Go to top menu [F9] then menu Image -> Check Image. Or press [Ctrl]+[C] 

- Load image configuration file (*.dim) or compose image from chunks the same way as it was 

explained in Disk Image Restoration section 

- Press [OK] in Compose Image dialog to initiate a check process 

- See progress and checking result. You can stop a process any time by pressing [ESC] 

Copying files and folders from of Disk Image to another location 

 

After completion of disk image creation you can open a disk image, see its folder structure and 

copy some files and folders from image to another location. 

 

To open disk image and to copy files and folders from it: 

- Start Active@ Disk Image 

- Go to top menu [F9] then menu Image -> Open Image. Or press [Ctrl]+[O] 

- Load image configuration file (*.dim) or compose image from chunks the same way as it was 

explained in Disk Image Restoration section 

- Press [OK] in Compose Image dialog to open and add disk image to the list of available 

devices. After this list is refreshed, marker will be positioned on your image: 



 

 
 

- Position a marker to logical drive ( Image (1:) in the example above) and press [ENTER] to 

scan a disk image for files and folders 

- Use arrows, [ENTER] and [TAB] keys to go through the folders tree until you find file or 

folder you want to copy from the image to another location: 

 

 
 

- Press [Ctrl]+[C] to invoke destination location dialog for the files and folders to be copied. 

- Choose destination location and press [ENTER] to start copying progress. 

Long file names display 

Starting from Windows 95, file name is not limited to [8.3] pattern anymore and can have the 

length up to 255 characters. 

 

Standard View displays all files and folders the same way as DOS does, i.e. forms file name 

using [8.3] format and displays it. However sometimes it is not convenient to see the only first 

several symbols of the long file name.  

 



 
 

To display long file names:  

- Boot in DOS mode and run Active@ Disk Image  

- Position marker to the particular drive, or opened disk image 

- Scan the drive and folder by pressing [ENTER]  

- Press [SHIFT]+[TAB] key to switch to long filenames view 

 

Using Disk Viewer  

  

Disk Viewer allows you to view any sector on the physical or logical drive.  

It can also display the file content in hex or text form. 

 

To use Disk Viewer to view raw drive’s data: 

- Select the HDD to view physical sectors or Logical drive to view logical sectors 

- Press the [Ctrl]+[V] to open Disk Viewer 

 

To use Disk Viewer to view file data: 

- Select a Logical Disk containing files you are interested in 

- Press [ENTER] to scan the disk, then go through the folder tree and set the marker to the 

file you are interested in 

- Press the [ENTER] (or select View File Data from View menu) to open Disk Viewer 

 

 
 



The title displays the object to be viewed and the current sector number will be shown below. 

The rest of the area displays sector content in Hex view on the left side and Text View on the 

right side.  

 

- Use arrows, [HOME], [END] keys to scroll the view 

- Use [Page Down], [Page Up] keys to go to the next/previous sector 

- Press [Ctrl]+[G] to go to the particular sector  

- Press [TAB] key to toggle between Hex view and Text view (available for files only) 

 

Menu Commands 

 

Being in main program window, press [F9] in order to enter main menu. 

 

File | Refresh Devices 

Refresh list of devices and disks. Might be useful after opening a disk image though 

device list will be refreshed automatically or after changing diskette in floppy drive 

 

File | Save Hardware Info 

Save information about all devices and disks presented in the system into text file 

(testfile.dat by default). Use this command to make info file before contacting technical 

support in case of problems 

 

File | Save Log 

 Save activity log into text file 

 

File | Exit 

 Exit the program 

 

View | Activity Log 

View activity log in new window. Press [ESC] to close log window and return to main 

window 

 

View | Sectors in Hex Viewer 

 View contents of selected disk in Hex Viewer. Press [ESC] to close Hex Viewer window 

and return to main window 

 

View | Drive Scan 

 Show the contents (files and folders) of selected disk (partition) 

 

Image | Create Raw Image 

 See section Disk Image Creation 

 

Image | Create Data Image 

See section Disk Image Creation 

 

Image | Open Image 

Open disk image and add it to the list of devices. You can view the contents of opened 

image and view/copy selected files from image. 

 

Image | Check Image 

 See section Checking Disk Image for consistency 

 

Image | Restore Image 

 See section Disk Image restoration 

 

 

 



FAQ 
 

Why do I receive an error message while trying to save the disk image or 
restore it?  

   

Problem: 

While saving or restoring I receive an error message saying "Error writing physical sector".  

 

Reasons: 

1. You attempted to run the software from Windows 95/98/ME "MS-DOS Prompt" console.  

2. Hard Disk Drive is physically damaged (i.e. has bad clusters).  

 

Solutions: 

1. DO NOT try to run the software from under Windows Operating System! Boot your 

computer in "Command Prompt" mode (press [F8] when Windows 95/98 boots) or boot from 

the floppy disk. See section OPERATING PROCEDURE about running the application. 

2. If your HDD is physically damaged, it's better to copy all important data from there and use 

another Hard Disk Drive or you are at risk of loosing your data. 

 

What is the difference between Raw Image and Data Image?  

 

Raw image – image containing all drive’s data – an exact copy of drive’s surface stored in 

one or set of files. It includes used as well as unused clusters and sectors. This means that all 

existing and even some deleted files would be mirrored to another location. Raw image has 

usually size larger than Data Image, but gives full picture of data, no one bit of data is missed 

in this case. 

 

Data Image – image containing the only used drive’s clusters. Data Image is applicable for 

logical drives and partitions only. When you recover Data Image later on – all unused clusters 

would be just zeroed. This approach however can save you a space and increase a speed of 

disk image creation. Since Data Image operates with term used clusters, it applicable to 

partition (logical volume) only, because only they have file structure. You wouldn’t be able to 

make a data image of entire disk – only raw image. 

 

 

 


